
1 
 

Министерство образования Республики Беларусь 

Учреждение образования 

«Белорусский государственный университет  

информатики и радиоэлектроники» 

 

Кафедра теоретических основ электротехники 

 

 

 

Д. П. Кукин, И. Л. Свито 
 
 

 

 

МОДЕЛИРОВАНИЕ ЭЛЕКТРОННЫХ УСТРОЙСТВ 
 

Лабораторный практикум 

для студентов  специальности 1-36  04 02 

  «Промышленная электроника»  

всех форм обучения 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Минск БГУИР 2012 

Би
бл
ио
те
ка

 БГ
УИ
Р



2 
 

УДК [621.38+004.4](076.5) 

ББК 32.85я73+32.973.26-018.2я73 

        К89 

 

 

 

Р е ц е н з е н т: 

заведующий кафедрой информатики учреждения образования 

«Минский государственный высший радиотехнический колледж»,  

кандидат технических наук, доцент Ю. А. Скудняков 

 

 

 

 

 

 

Кукин, Д. П.  

К89    Моделирование электронных устройств : лаб. практикум для студ. 

спец. 1-36 04 02 «Промышленная электроника» всех форм обуч. /  

Д. П. Кукин, И. Л. Свито. – Минск : БГУИР, 2012. – 53 с. : ил. 

  ISBN 978-985-488-739-5. 

   
  Рассмотрена система сквозного автоматизированного проектирования элек-

тронных схем Orcad: Orcad Capture, Orcad Layout. Лабораторный практикум содержит 

описание четырех лабораторных работ, выполняемых на персональных ЭВМ при по-

мощи программы Orcad,  и краткие теоретические сведения. 
 

            УДК [621.38+004.4](076.5) 

ББК 32.85я73+32.973.26-018.2я73 

  

 

 

ISBN 978-985-488-739-5                                  © Кукин Д. П., Свито И. Л., 2012 

                   © УО «Белорусский государственный  

                университет информатики 

                и радиоэлектроники», 2012 

Би
бл
ио
те
ка

 БГ
УИ
Р



3 
 

Содержание 

 
1. Общие сведения о программах OrCAD .......................................................... 4 

2. Общая характеристика программы OrCAD Capture ..................................... 5 

 2.1.  Меню команд и панель инструментов ...................................................... 6 

 2.2. Редактор схем .............................................................................................. 8 

3. Общая характеристика программы OrCAD Layout ..................................... 10 

 3.1.  PCB, Components ....................................................................................... 10 

 3.2.  Библиотека компонентов ......................................................................... 12 

 3.3.  Подготовка данных для Layout Plus ........................................................ 14 

 3.3.1.  Подготовка данных для Layout Plus ............................................ 14 

 3.3.2.  Forward Annotating ......................................................................... 18 

 3.3.3.  Граница платы ................................................................................ 22 

 3.4.  Ручное размещение компонентов на плате ............................................ 23 

 3.4.1.  Параметры дизайна OrCAD Layout ............................................. 23 

 3.4.2.  Общая идеология расстановки компонентов ............................. 25 

 3.5.  Разводка платы. ......................................................................................... 26 

 3.5.1.  Настройка параметров .................................................................. 26 

 3.5.2.  Manual Fanout ................................................................................. 29 

4.  Лабораторный практикум................................................................................ 31 

    4.1.  Лабораторная работа №1 .......................................................................... 31 

    4.2.  Лабораторная работа №2 .......................................................................... 34 

     4.3.  Лабораторная работа №3 .......................................................................... 37 

     4.4.  Лабораторная работа №4 .......................................................................... 46 
 

 

 

 

 

 

 

 

 

Би
бл
ио
те
ка

 БГ
УИ
Р



4 
 

1. Общие сведения о программах OrCAD 

Среда OrCAD предназначена для проектирования электронных схем, об-

ладает большими функциональными возможностями и является сложной си-

стемой. Описать любую сложную систему также непросто. Это усложняет как 

процесс обучения начинающих, так и межпользовательский обмен. Количество 

задач, которые возникают или могут возникнуть при ее эксплуатации в режиме 

моделирования, очень велико. Существуют подробные и большие по объему 

инструкции по пользованию средой OrCAD. 

Среда OrCAD является мощным универсальным современным средством 

сквозного проектирования электронных систем и обладает широкими возмож-

ностями. По функциональным возможностям среда разделяется на две части, 

обеспечивающие моделирование электронных систем и проектирование печат-

ных плат. 

Часть среды, обеспечивающая моделирование, состоит из следующих 

программ: 

– OrCAD Capture – графический редактор, предназначенный для создания 

моделей электрических схем из моделей элементов; 

– OrCAD Capture CIS (Component Information System) – выполняет те же 

функции, что и OrCAD Capture, однако возможности этой программы рас-

ширены за счет того, что справочная информация может находиться через 

Internet, при этом зарегистрированный пользователь получает доступ к ин-

формации приблизительно о 200 тысячах электронных компонентов; 

– PSpice Schematics – графический редактор, использовавшийся в среде 

Design Lab 8.0. Хронологически среда Design Lab 8.0 является предшествен-

ницей OrCAD 9.2 и имеет с ней много общего. Возможности графического 

ввода информации в PSpice Schematics ограничены (по сравнению с OrCAD 

Capture и OrCAD Capture CIS), однако этот редактор имеет удобства, связан-

ные с редактированием кода моделей, созданием новых моделей с расширен-

ными функциональными характеристиками. В литературных источниках по 

OrCAD 9.2 и Design Lab 8.0 имеется много полезных примеров, в которых 

приводятся коды моделей, записанные аналитически на языке PSpice; 

– OrCAD PSpice – программа моделирования в среде OrCAD. Эта програм-

ма создавалась как самостоятельное средство моделирования и достаточно 

широко применяется в различных средах моделирования; 

– OrCAD Probe – программа, позволяющая осуществлять обработку ре-

зультатов моделирования в виде осциллограмм; 

– OrCAD PSpice Model Editor – программа, предназначенная для создания и 

редактирования математических моделей электронных элементов; 

– OrCAD Stimulus Editor – программа, использующаяся при создании и ре-

дактировании моделей источников сигналов; 

– OrCAD PSpice Optimizer – программа параметрической оптимизации ре-

жимов работы моделей методом наискорейшего спуска; 
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– PSpice Simulation Manager – программа, обеспечивающая очередность ра-

боты со схемами, ожидающими моделирования или находящимися в процес-

се моделирования. Пользователь имеет возможность приостановить текущее 

моделирование, запустить анализ другой схемы, а затем вернуться к первой. 

Возможна расстановка приоритетов в очереди. 

2. Общая характеристика программы OrCAD Capture 

Программа OrCAD Capture предназначена для создания проекта, часть 

которого может быть задана в виде принципиальной электрической схемы, а 

другая часть может быть описана на языке высокого уровня VHDL . Кроме то-

го, из оболочки OrCAD Capture запускаются программы моделирования анало-

говых, цифровых и смешанных аналого-цифровых устройств PSpice и парамет-

рической оптимизации PSpice Optimizer. В программе OrCAD Capture проекты 

подразделяются на несколько типов. 

 

 
Рис. 2.1 

При создании проекта в соответствии с его типом автоматически загру-

жаются необходимые библиотеки компонентов (позднее их перечень можно 

изменить вручную), при этом для всех специализированных проектов возможна 

передача информации в программу OrCAD Layout для создания печатных плат 

(ПП). На рис. 2.1 показана взаимосвязь OrCAD Capture с другими программами 

системы OrCAD. При создании принципиальных схем проекта необходимая 

информация отыскивается во встроенной базе данных, которая поставляется 

вместе с системой и пополняется пользователями. Причем при наличии оп-
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ции Component Information Systems (CIS) официальные пользователи получают 

доступ через Интернет к расширенной базе данных, содержащей сведения при-

мерно о 200 тыс. различных компонентов. 

На рис. 2.2 изображен экран программы OrCAD Capture 16.3. В его верх-

ней части расположено меню команд, а ниже – панель инструментов. 

 

 
Рис. 2.2 

 

2.1. Меню команд и панель инструментов 
 Состав пиктограмм панели инструментов зависит от выбранного режима 

работы и типа текущего проекта, их состав изображен на рис. 2.3 и приведен в 

табл. 2.1. 

 

 
Рис. 2.3 

 

Состав меню команд зависит от выбранного режима работы и типа текущего 

проекта. 
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Таблица 2.1 

 

Пиктограммы панели инструментов 

Пиктограм-

ма 

Эквивалентная 

команда 
Описание команды 

1 2 3 

 New Создание нового документа 

 Open Открытие существующего документа 

 Save 
Сохранение внесенных изменений в теку-

щем проекте 

 Print 

Вывод твердой копии одной или более 

страниц текущей схемы или изображения 

символа компонента 

 Cut 
Удаление выбранного объекта с копирова-

нием в буфер обмена 

 Copy 
Копирование выбранного объекта в буфер 

обмена 

 Paste Размещение объекта из буфера обмена 

 Undo 
Отмена результата выполнения одной по-

следней команды 

 Redo 
Отмена результата выполнения одной по-

следней команды Undo 

 Zoom In Увеличение масштаба изображения 

 Zoom Out Уменьшение масштаба изображения 

 Zoomto region 
Вывод на весь экран окаймленной части 

изображения 

 Zoomto All 
Вывод на экран полного изображения 

страницы схемы 

 Annotate 
Назначение позиционных обозначений 

компонентам выбранной страницы схемы 

Би
бл
ио
те
ка

 БГ
УИ
Р



8 
 

  Окончание табл. 2.1 

1 2 3 

 Back Annotate 

Выполнение перестановок логически эк-

вивалентных секций компонентов и выво-

дов в процессе обратной корректировки 

 
Design Rules 

Check 

Проверка соблюдения правил проектиро-

вания  DRC  и правил составления элек-

трических принципиальных схем  ERC 

 Create Netlist 

Составление файла списка соединений вы-

бранной страницы схемы в форматах 

EDIF200, SPICE, VHDL, Verilog, Layout 

и др. 

 Cross Reference Составление файла перекрестных ссылок 

 Billof Materials 
Составление отчета о проекте или выбран-

ной странице 

 Snapto Grid 

Привязка курсора к узлам сетки на окне 

редактирования схем и символов компо-

нентов (аналог команды Options → 

Preferences → Grid Display) 

 Project manager Загрузка менеджера проектов 

 Help Topics 

Вывод содержания, предметного указателя 

и средств поиска терминов встроенной ин-

струкции 

 

2.2. Редактор схем 

Состав пиктограммы панели инструментов режима редактирования схем 

зависит от выбранного режима работы и типа текущего проекта, их состав 

изображен на рис. 2.4 и приведен в табл. 2.2. 

 

 
 

Рис. 2.4 
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Таблица 2.2 
 

Пиктограммы панели инструментов режима редактирования схем 

Пиктограмма 
Эквивалентная 

команда 
Описание команды 

1 2 3 

 Select Режим выбора объектов 

 Part 
Выбор в библиотеке компонента для 

размещения его символа на схеме 

 Wire 

Рисование электрических цепей. При 

нажатии кнопки SHIFT возможен ввод 

неортогональных цепей 

 Net Alias 
Размещение псевдонимов (дополнитель-

ных имен) цепей и шин 

 Bus 
Изображение шины (линии групповой 

связи) 

 Junction 
Нанесение точки электрического соеди-

нения двух цепей 

 Bus Entry 
Нанесение отводов от шины, располо-

женных под углом 45° 

 Power 
Размещение символов выводов источни-

ков питания 

 Ground Размещение символов выводов «земли» 

 
Hierarchical 

Block 
Размещение иерархических блоков 

 
Hierarchical 

Port 

Размещение портов иерархических бло-

ков 

 
Hierarchical H 

Pin 

Размещение выводов иерархических 

блоков 

 
Off-Page 

Connector 

Размещение символов соединителей 

страниц 

 No Connect 
Подключение к выводу компонента сим-

вола отсутствия соединений 

 Line Рисование линии 

 Polyline Рисование полилинии 
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Окончание табл. 2.2 

1 2 3 

 Rectangle Рисование прямоугольника 

 Ellipse Рисование эллипса /окружности 

 Arc Рисование дуги 

 Text 
Размещение одной или нескольких строк текста с указанием 

его размера, цвета, ориентации и шрифта 

 

3. Общая характеристика программы OrCAD Layout 
 

3.1. PCB, Components 

PCB (Printed Circuit Board), Board, или просто печатная плата, помимо 

собственно основания из гетинакса или стеклотекстолита состоит из компонен-

тов (Components). 

Вот как определяется понятие компонента в справочной системе Layout: 

«Элемент или часть. Плата состоит из компонентов, установленных на общем 

основании (поверхности) и соединѐнных медными дорожками (проводника-

ми)». (An element or a part. PCBs are made up of components affixed to a common 

surface and connected by copper tracks). 

Компоненты могут быть электрическими и неэлектрическими. 

 
Рис. 3.1 
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Примером электрических компонентов могут быть радиодетали, установ-

ленные на плате. Это микросхемы, резисторы, разъѐмы и пр. Электрическими 

компонентами в некоторых случаях могут являться переходные отверстия. 

Крепѐжные отверстия также являются компонентами, и  если они выполнены с 

металлизацией, то могут быть электрически соединены с какой-либо цепью на 

плате (как правило, с корпусной «землѐй»). 

Примером неэлектрических компонентов могут служить те же крепѐжные 

отверстия, если они выполнены без металлизации или просто не участвуют в 

разводке, любые механические элементы и элементы оформления. 

Как видно, далеко не все компоненты принимают участие в электриче-

ской разводке (маршрутизации, трассировке, routing). Также не все компоненты 

«affixed to a common surface» находятся непосредственно на плате. 

Перед вами – завершѐнная печатная плата (рис. 3.1).  

Обратите внимание: в верхней части экрана расположена панель инстру-

ментов (рис. 3.2): 
 

 
Рис. 3.2 

 

Кнопкой, на которую указывает курсор, мы будем пользоваться чаще все-

го. Она даѐт быстрый доступ к параметрам всех элементов, составляющих наш 

проект. Вот еѐ меню (рис. 3.3). 
 

 
Рис. 3.3 

 

Если будет написано «Выберите Text»», это значит, что необходимо 

нажать на кнопку «View Spread sheet» и из раскрывшегося меню выбрать пункт 

«Text». 

В противном случае будет написано: «Выберите Tool – Text – Select From 

Spread sheet...». Это значит, что надо выбрать указанный пункт через систему 

меню Layout Plus (рис. 3.4). 
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Рис. 3.4 

 

3.2. Библиотека компонентов 

Запустите OrCAD Layout Plus. Откроется окно Layout Session. Теперь 

войдите в «Tools  Library Manager» (рис. 3.5). 

 
Рис. 3.5 
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Откроется окно Layout Plus с менеджером библиотек. 

Кнопка «1» в панели инструментов позволяет переключаться между Li-

brary manager и окном проекта. То же самое действие можно совершить, ис-

пользуя комбинацию клавиш  <Ctrl-I>. 

В поле «2» показаны доступные в данный момент библиотеки. При пер-

вом запуске видны только библиотеки, которые поставляются вместе с OrCAD 

Layout. 

Если вы создали свою собственную библиотеку компонентов и хотите еѐ 

использовать, воспользуйтесь кнопкой <Add...>. 

Кнопка <Remove> позволяет убрать ненужную библиотеку из списка, од-

нако это не значит, что библиотека также будет физически стѐрта с компьютера. 

В поле «3» отображаются названия доступных footprint из выбранной 

библиотеки. 

В окне «4» мы видим изображение выбранного footprint. 

В строке состояния «5» приводится дополнительная информация, из ко-

торой наиболее важной являются координаты курсора или перемещаемого объ-

екта. Они заключены в квадратные скобки и отображаются в соответствии с 

сеткой привязки (Grid). 

Войдите в «Options  System Settings...» или нажмите <Ctrl-G>  

(рис. 3.6). 

 
Рис. 3.6 

Нас интересуют два поля в открывшемся окне: «Display Units» и «Grids». 

В левом устанавливаются единицы измерения, которые будут использоваться в 

проекте; в правом устанавливаются сетки привязки. 

Сетки привязки служат для упорядоченного размещения объектов на ра-

бочем поле. Таким образом, все объекты располагаются не хаотично, а «по кле-

точкам». В OrCAD Layout «клеточки» квадратные, но, вообще говоря, сетки 

привязки могут иметь и прямоугольную форму и даже, если нужно, шести-

угольную. К тому же для разных объектов могут быть установлены различные 

сетки. 
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В Layout пять сеток: 

– Visible grid – сетка, которая отображается на экране в виде белых 

точек. Служит исключительно для удобства; 

– Detail grid – сетка привязки для текста и так называемых 

«Obstacles»; 

– Place grid– сетка для размещения компонентов; 

– Routing и Via grid – сетки привязки для дорожек и vias соответ-

ственно. 

В зависимости от инструмента, с которым мы работаем, шаг сетки пока-

зывается в панели инструментов рядом с буквой «G»  (рис. 3.7). 

 

 
Рис. 3.7 

 

«X» и «Y» – координаты курсора. 

Единицы измерения, применяемые в Layout: 

– английская (дюймовая) система измерений: основная используемая 

единица – миль (m); 

– метрическая система измерений: основная используемая  единица – 

миллиметры (mm). 

Каждому компоненту соответствует его footprint. Дословный перевод слова 

«footprint» – отпечаток ноги, след. В нашем случае это изображение компонен-

та и описание его посадочного места на плате. Footprint компонентов хранятся в 

библиотеке и содержат информацию о физических размерах компонента, его 

изображения; количестве, типе и размерах контактных площадок (padstacks); а 

также текст (например Reference Designator компонента). 

 

3.3. Подготовка данных для Layout Plus 

3.3.1. Подготовка данных для Layout Plus 

У нас есть схема, теперь нужно установить соответствие каждого элемен-

та принципиальной схемы его footprint из библиотеки. 

Сделать это можно разными способами. 

Способ #1. Определим footprint для элемента U2. Найдите его на схеме и 

дважды щѐлкните по нему левой кнопкой мыши. Откроется окно свойств объ-

екта (рис. 3.8). 
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В поле PCB Footprint введите название footprint в точности так, как вы его 

определили в библиотеке. 

Этот способ удобен тем, что мы видим элемент прежде, чем задаѐм его свой-

ства. Однако если нужно описать свойства группы элементов, то лучше вос-

пользоваться другим методом. 

Находясь в OrCAD Capture, перейдите в окно Project Manager. 

Укажите мышкой на файл дизайна, как показано на рис. 3.9, а затем вой-

дите: «Edit – Object Properties...». Откроется Property Editor  –  общая таблица 

свойств всех элементов схемы (рис. 3.10). 

Убедитесь, что в нижней части экрана выбрана вкладка Parts (рис. 3.11). 

 

 
Рис. 3.10 

Рис. 3.8 

Рис. 3.9 
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Сдвиньте столбцы так, как вам более удобно. Для этого выделите нужный 

столбец и перетащите его мышкой в новую позицию (рис. 3.11). Например так, 

чтобы столбцы Graphic и PCB Footprint были рядом. 

 
 

Р
и

с.
 3

.1
1
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Для того чтобы изменить какое-либо свойство группы элементов, выде-

лите необходимые ячейки мышкой, используя клавиши <Ctrl> или <Shift>. 

Проделайте это для элементов C2, C3, C5, C6, а затем нажмите <Ctrl>+<E>. 

 

Укажите название footprint для этих конденсаторов, как показано  

на рис. 3.12. 

Проделайте аналогичную работу для всех остальных компонентов, ис-

ключая LD1-LD4, как показано на рисунке. 

Надо сказать, что Property Editor показывает вам не всѐ. Чтобы не загро-

мождать экран лишними данными, для вывода информации используются 

фильтры. 

Попробуйте самостоятельно подобрать такой фильтр, чтобы стал виден 

столбец «Color» (рис. 3.13), после чего измените цвет R1 и R2 на оранжевый, а 

SW5 – на темно-зелѐный. 

Рис. 3.13 

Для того чтобы создать свой собственный фильтр, щѐлкните правой 

кнопкой мыши по заголовку одного из столбцов, выберите «Filters – Add 

Filter...» (рис. 3.14) и укажите имя нового фильтра. Новый фильтр будет создан, 

и на экран будут выведены абсолютно все свойства. 

Рис. 3.12 
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Рис. 3.14 

С помощью этого же меню выберите столбцы, которые вы хотите скрыть.  

3.3.2. Forward Annotating 

Мы ещѐ совсем не закончили работать ни со схемой, ни с Capture. Однако 

подготовленных данных вполне хватает, чтобы начать работать в Layout Plus. 

Сейчас мы попробуем запустить Layout-сессию, а затем посмотрим, как можно 

вносить новые данные в уже существующий дизайн. 

Процесс передачи данных из OrCAD Capture в Layout называется «For-

ward Annotating». Он состоит из двух этапов: подготовка Netlist-а в OrCAD Cap-

ture и последующая трансляция его в Layout. 

Netlist – это словесное описание принципиальной схемы. Capture создаѐт 

файл особого формата, понятный Layout, в котором записана вся информация о: 

– компонентах, используемых в схеме; 

– соединениях; 

– общие сведения, такие, например, как размерность системы изме-

рений. 

 
Рис. 3.15 
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Для того чтобы создать netlist в OrCAD Capture, перейдите в окно Project 

Manager и нажмите кнопку на панели инструментов Create Netlist (рис. 3.15, 

3.16). 

Рис. 3.16 

В открывшемся окне выберите вкладку Layout, а в поле Options – обяза-

тельно укажите «User Properties are in inches» (рис. 3.17)! 

        Рис.3.17 

 

 

 
     Рис. 3.18
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Нажмите <OK>, и увидите, что в окне проекта появился новый файл 

clock.mnl. Это и есть файл netlist (рис. 3.18). 

Netlist не будет создан, если на схеме имеются элементы с одинаковыми 

Reference Designator. Ошибка произойдѐт и в том случае, если у одного из эле-

ментов имеются выводы с одинаковыми номерами. 

Созданный файл имеет двоичный формат. Посмотреть его содержимое 

можно, воспользовавшись возможностями экспорта Layout. 

В окне Layout Session выберите команду «File – Export – MAX ASCII 

Netlist». Укажите путь ко входному файлу, задайте имя выходного, и получите 

файл clock.asc, который можно открыть любым текстовым редактором. 

Трансляция netlist в Layout Plus осуществляется утилитой AutoECO. За-

пустите Layout Session и выберите «File – New». Мы начинаем новую плату! 

В открывшемся окне (рис. 3.19) в поле Options выбрано «AutoECO». Об-

ратите внимание на пояснения, следующие ниже. Именно этот вариант исполь-

зуется, если вы только начинаете работать. 

Рис. 3.19 

 

Как мы увидим дальше, утилита AutoECO используется не только во вре-

мя создания новой платы, но и для всех случаев, когда нужно обновить данные 

из Capture в Layout, касающиеся изменения схематики. 

Вариант «AutoECO» выбирается всегда, если в схеме произошли какие-то 

принципиальные изменения. Например, если были добавлены или удалены 

компоненты или изменились соединения между элементами. Соответствующие 

компоненты будут добавлены на печатной плате, ненужные более – удалены, а 
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цепи переподключены заново. При этом свойства уже существующих в Layout 

элементов не изменятся. 

Об этом мы ещѐ поговорим, а сейчас в поле 2 укажите путь к файлу 

clock.mnl, а в поле 1 – путь к файлу _default.tch. 

Файлы с расширением .tch это так называемые «Technology   Templates» – 

технологические шаблоны. Они используются, если вы начинаете работу над 

новой печатной платой и содержат информацию об основных правилах постро-

ения дизайна, как то: 

– количество слоѐв в будущей плате; 

– установки для сеток привязки; 

– правила размещения компонентов; 

– правила трассировки и ширина треков; 

– заготовки padstacks; 

– color rules, т. е. цветовые таблицы и т. д. 

В некоторых случаях вместо Technology Templates в поле 1 подставляется 

файл с расширением .tpl. Это – файл «Board Templates» – заготовки плат. Board 

Templates используются для разработки серии схожих PCB и помимо перечис-

ленной выше информации могут содержать в себе данные о физических разме-

рах печатной платы, предустановленные компоненты (такие, как крепѐжные 

отверстия, коннекторы и пр.), текст и уже готовые элементы оформления. 

В поле 1 подставляется уже существующая плата, если требуется произ-

вести обновление данных. 

В поле 3 задается имя результирующего файла. Layout Plus работает с 

файлами PCB, имеющими расширение .max. Самый первый файл обычно назы-

вается «00.max», а последующие – «01.max», «02.max» и т.д. Это позволяет не 

запутаться в версиях и спасает от возможных сбоев компьютера, потому что 

всегда даѐт возможность вернуться на произвольное количество шагов назад, 

если вдруг выяснится, что произошла какая-либо ошибка. 

Нажимаем кнопку <ApplyECO> и ждѐм результата (рис. 3.20). 

 

 

     Рис. 3.20 
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В конце нам будет выдан отчѐт, после чего Layout откроет окно дизайна, 

в котором будет присутствовать таблица Drill Chart, а рядом – все наши компо-

ненты, аккуратно отсортированные по footprint и соединѐнные жѐлтыми ниточ-

ками цепей (ratsnest) (рис. 3.21). 

 

 
Рис. 3.21 

Отчѐт AutoECO можно просмотреть повторно. Он находится в рабочей 

директории в файлах с расширением .lis. 

Ошибки во время трансляции записываются в файлы .err. Названия фай-

лов совпадают с названием главного файла (файла .max). 

3.3.3. Граница платы 

После Forward annotating необходимо определить размеры и форму бу-

дущей печатной платы. Сделать это можно тремя способами. 

Первый – загрузить заготовку платы из шаблона. Если бы у нас была та-

кая заготовка, еѐ следовало бы указать в поле «Шаблоны». Заготовки у нас нет, 

поэтому перейдѐм ко второму способу. 

Второй способ заключается в том, чтобы, используя инструмент Obstacle 

Tool, нарисовать контур платы вручную. Как вы помните, мы должны исполь-

зовать obstacle Board Outline, расположенную в слое Global. Рисовать можно 

мышкой, используя сетку привязки или последовательно вводя координаты 

вершин фигуры, которая образует нашу плату. 

Рисовать различные фигуры вы уже умеете, поэтому рассмотрим третий 

способ. 

Третий способ заключается в импорте чертежа PCB, который подготовил 

для вас инженер-механик в программе AutoCAD или SolidWorks. 
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3.4. Ручное размещение компонентов на плате 

3.4.1.     Параметры дизайна OrCAD Layout 

Количество и тип используемых слоѐв 

С целью обучения предлагается изготовить четырѐхслойную плату, при-

чѐм внутренние слои будут типа PLAIN. 

Определим два внутренних PLAIN-слоя, из которых один будет служить 

для разводки земли, а второй – для разводки питания. Причѐм рассмотрим, как 

на одном PLANE-слое возможно развести одновременно две питающие цепи. 

Откройте «Layers». Должно быть определено 6 маршрутизируемых слоѐв, 

как показано на рис. 3.22. А именно: два наружных слоя – TOP и BOTTOM, два 

внутренних – INNER1 и INNER2, и два слоя типа Plane – GND и POWER. 

 

 
Рис. 3.22 

Уберите слои INNER, присвоив им «Unused» (рис. 3.23). 

 

 
Рис. 3.23 

 

Остальные слои должны быть определены так, как это показано  

на рис. 3.24. 
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Рис. 3.24 

Два слоя маски – SM; два слоя паяльной пасты для монтажа SMD-

компонентов – SP; два слоя Silkscreen – SS; монтажные слои – ASY; слои свер-

ления – DRLDWG и DRILL. Таков минимальный набор слоѐв, который нам 

может понадобиться. 

Правила размещения 

Следующий шаг – определение таких параметров, как минимально допу-

стимое расстояние между дорожками и другими объектами на плате. 

Войдите: «Options – Global Spacing...». Откроется таблица (рис. 3.25).  

Рис. 3.25 

Несмотря на то что команда называется «Global Spacing», имя  таблицы – 

«Route Spacing», т. е. речь идѐт только о правилах, касающихся трассировки. 

В OrCAD Layout не определяются общие правила для расстояния между 

компонентами. Считается, что это не нужно, т. к. физические границы каждого 

компонента описываются obstacle Place Outline. Единственное правило, которо-

го должны придерживаться вы и придерживается программа – это то, что obsta-

cles Place Outline не должны перекрываться. 
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В таблице указываются расстояния между маршрутизируемыми объекта-

ми в каждом слое: дорожками (vias) и контактными площадками (pads). Зоны 

заливки медью эквивалентны дорожкам (tracks). 

3.4.2.  Общая идеология расстановки компонентов 

Расстановка компонентов производится в следующем порядке: 

– сначала устанавливаются на плату те компоненты, положение которых опре-

делено заранее. В первую очередь – элементы крепежа. Понятно, что если плата 

не сможет войти в корпус устройства или неправильно определены крепѐжные 

вырезы и отверстия, то дальнейшая разводка теряет смысл. Всѐ равно придѐтся 

всѐ переделывать; 

– во вторую очередь устанавливаются органы управления, если они есть, а так-

же разъѐмы, индикаторы и т. д. То есть все те элементы, которые выступают 

наружу из корпуса будущего устройства. Положение на PCB всех этих компо-

нентов, как правило, уже оговорено заранее; 

– потом, исходя из расположения установленных компонентов, расставляются 

остальные. Начинаем с внешних разъѐмов. Самые    критичные – разъѐмы, к ко-

торым подключаются какие-либо датчики для измерений. Во избежание иска-

жений и наводок на измеряемый сигнал компоненты, подключѐнные к таким 

разъѐмам, должны располагаться в самой непосредственной от них близости; 

– далее условно, в порядке убывания важности, можно назвать высокочастот-

ные разъѐмы, разъѐмы высокоскоростной связи, силовые коннекторы и т. д.; 

– постепенно плата заполняется. Оставшееся место, согласно принципиальной 

схеме, нужно рационально распределить между функциональными блоками 

устройства, приблизительно определить для каждого блока его место. На этом 

этапе, возможно, вы увидите, что кое-какие из внешних коннекторов было бы 

хорошо переставить или поменять местами. Возможно, стоит настоять на своѐм 

мнении; 

– после того как вы определились с компоновкой PCB, начинайте расстановку 

компонентов по очереди для каждого модуля. Начните с самых крупных ком-

понентов, хотя тут нельзя посоветовать однозначно. Установив, к примеру, 

большую интегральную микросхему, расположите вокруг «сопровождающие» 

еѐ детали. Затем принимайтесь за следующую. 

Расставляя компоненты, смотрите, как располагаются ratsnests. Распола-

гайте компоненты так, чтобы цепи как можно меньше запутывались. Распола-

гая компоненты слишком близко, думайте, сможете ли вы потом вывести от 

них дорожки, хватает ли места, чтобы можно было поставить via? Если у вас 

многослойная плата, не думайте, что развести еѐ будет намного легче! Vias тре-

буют гораздо больше пространства вокруг себя, поэтому поставить лишнюю via 

подчас труднее, чем провести пару дорожек. 

Если плата большая, то иногда следует провести пробную разводку толь-

ко что скомпонованного участка. 
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Располагайте компоненты как можно плотнее, даже если места достаточ-

но. Лучше потом, если понадобится, раздвинуть их. 

Расположив на плате самые критичные компоненты и компоненты, поло-

жение которых было указано заранее, можно заблокировать их командой 

«Lock» и попробовать использовать функцию Layout Plus Autoplacement, т. е. 

«Автоматическое размещение». 

 

3.5. Разводка платы 

3.5.1. Настройка параметров 

На каждом новом этапе работы прежде всего мы проверяем соответству-

ющие настройки. 

Первое: проверим ещѐ раз свойства obstacle Board Outline – границы пла-

ты. Нас интересует толщина obstacle. Мы установили этот параметр – 25 милей. 

Половина толщины obstacle Board Outline определяет минимальное рас-

стояние от края платы до установленных компонентов, дорожек, слоѐв Plane и 

зон заливки медью. 

Второе: определим сетки трассировки и vias. Для этого вызовите окно 

System Settings и установите значения Routing grid иVia grid равными 6,25 ми-

лей (рис. 3.26). 

Рис. 3.26 

Пусть вас не беспокоит такая малая величина. Современные технологии 

позволяют делать печатные платы с очень высокой плотностью разводки. Во 

многих случаях разрешается даже совсем не определять сетку для vias. 

Впрочем, возможно, стоит проконсультироваться на эту тему с техноло-

гом предприятия, где вы собираетесь заказывать свои платы. 

Третье: необходимо задать набор vias, которые мы будем использовать. 
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Откройте таблицу Padstacks. В данный момент определѐн только один тип vias 

(рис.  3.27). 

VIA1 – это via, используемая по умолчанию. Для нас она слишком вели-

ка: посмотрите на диаметр отверстия. Он равен 28 милей. Это  около 0,7 мм! 

Ещѐ обратите внимание на строки SMTOP и SMBOT. Via открыта от маски. 

 

 
Рис. 3.27 

Такие переходные отверстия можно использовать как контрольные точки. 

К ним можно прикоснуться щупом осциллографа, а большое отверстие позво-

ляет даже припаять тонкий проводок. Однако, если мы не собираемся впослед-

ствии исследовать работу будущего устройства, via такого типа нам не нужны. 
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 Рис. 3.28 

Переопределите VIA1 в соответствии с рис. 3.28. 

Четвѐртое: нужно определить правила относительных расстояний. Для 

этого выполните команду:  <<Options —Global Spacing...>>. 

С этой таблицей мы уже не раз встречались (рис. 3.29).  

Рис. 3.29 

          Изменяя значения в столбцах, можно указать минимально возможное рас-

стояние для соседних дорожек, минимальное расстояние от дорожки до via, от 

дорожки до вывода компонента и т.д. 

Следует помнить, что для каждой цепи мы можем установить индивиду-

альные параметры,  используя Net Properties. 

Изменяя значения в строках, можно указать правила для каждого слоя 

индивидуально. 
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3.5.2. Manual Fanout 

Исправим найденные ошибки вручную, а заодно изучим простейшие при-

ѐмы ручной разводки. Для этого будем использовать инструмент Add/Edit Route 

Mode (рис. 3.30). 

                       Рис. 3.30 

 

Щѐлкните мышкой по дорожке 1 (рис. 3.31) и нажмите клавишу <D>, чтобы 

убрать стрингер. Дорожка исчезнет. Теперь щѐлкните мышкой по синей ниточ-

ке-ratsnest и соедините выводы, как показано на рис. 3.31. 

 
Рис. 3.31 

Обновите экран, и вы увидите, что синие ratsnests исчезли. Это означает, 

что цепь  +6V разведена полностью. 

Внесите исправления там, где нужно, и проверьте дизайн. Ошибок быть 

не должно, а сама плата должна выглядеть примерно так (рис. 3.32). 

 
Рис. 3.32
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Список «горячих» клавиш, используемых при ручной разводке: 

 

 
Некоторые дополнительные команды доступны по нажатии правой кноп-

ки мыши из контекстного меню. 
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4. Лабораторный практикум 

      4.1. Лабораторная работа №1 

Исследование характеристик биполярных транзисторов 

 

Цель работы:  

Изучение процесса моделирования аналоговых устройств в программе 

Capture.  

 

На рис. 4.1 изображена схема с усилителем на биполярных транзисторах. 

 

Каскад на БТ с ОБ 

 
Рис. 4.1 

Схема характеризуется отсутствием усиления по току (коэффициент пе-

редачи близок к единице, но меньше единицы), высоким коэффициентом уси-

ления по напряжению и умеренным (по сравнению со схемой с общим эмитте-

ром) коэффициентом усиления по мощности. Входной сигнал подаѐтся на 

эмиттер, а выходной снимается с коллектора. При этом входное сопротивление 

очень мало, а выходное – велико. Фазы входного и выходного сигнала совпа-

дают. 

Особенностью схемы с общей базой является минимальная среди трѐх 

типовых схем усилителей «паразитная» обратная связь с выхода на вход через 

конструктивные элементы транзистора. Поэтому схема с общей базой наиболее 

часто используется для построения высокочастотных усилителей, особенно 

вблизи верхней границы рабочего диапазона частот транзистора. Достоинством 

схемы является то, что схема имеет стабильные температурные и частотные 

свойства, т.е. параметры схемы (коэффициент усиления напряжения, тока и 

входное сопротивление) остаются неизменными при изменении температуры 

окружающей среды. Недостатком схемы является то, что нет усиления тока и 

малое входное сопротивление. 
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Параметры каскада на БТ с ОБ: фаза сигнала на выходе совпадает с фа-

зой сигнала на входе; коэффициент усиления  по току – меньше единицы; ко-

эффициент усиления по напряжению – десятки –  сотни раз; входное сопротив-

ление – десятки – сотни ом; выходное сопротивление – десятые доли – единицы 

килоом. 

 

Каскад на БТ с ОЭ 

 
Рис. 4.2 

 

При схеме включения биполярного транзистора с общим эмиттером 

(ОЭ) входной сигнал подаѐтся на базу, а снимается с коллектора. При этом фаза 

выходного сигнала отличается от фазы входного на 180°. Усиливает и ток, и 

напряжение. Данное включение транзистора позволяет получить наибольшее 

усиление по мощности, поэтому наиболее распространено. Однако при такой 

схеме нелинейные искажения сигнала значительно больше. Кроме того, при 

данной схеме включения на характеристики усилителя значительное влияние 

оказывают такие внешние факторы,  как напряжение питания или температура 

окружающей среды. Обычно для компенсации этих факторов применяют отри-

цательную обратную связь, но она снижает коэффициент усиления. 

Каскад на БТ с ОЭ характеризуется следующими типовыми значениями 

параметров: коэффициент усиления по току – десятки – сотни раз; коэффици-

ент усиления по напряжению – десятки – сотни раз (единицы – десятки раз при 

отсутствии конденсатора C2); входное сопротивление – десятые доли – едини-

цы килоом (единицы – десятки килоом при отсутствии конденсатора  C2); вы-

ходное сопротивление – десятые доли – единицы килоом. 
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Каскад на БТ с ОК (ЭП) 

 
Рис. 4.3 

Характеризуется высоким усилением по току и коэффициентом переда-

чи по напряжению, близким к единице. При этом входное сопротивление отно-

сительно велико (однако оно меньше, чем входное сопротивление истокового 

повторителя), а выходное – мало. 

В эмиттерном повторителе используется схема включения транзистора с 

общим коллектором (ОК). То есть напряжение питания подаѐтся на коллектор, 

а выходной сигнал снимается с эмиттера. В результате чего образуется  

100 % -ная отрицательная обратная связь по напряжению, что позволяет значи-

тельно уменьшить нелинейные искажения, возникающие при работе. Следует 

также отметить, что фазы входного и выходного сигнала совпадают. Такая схе-

ма включения используется для построения входных усилителей, в случае если 

выходное сопротивление источника велико, а также в качестве выходных кас-

кадов усилителей мощности. 

Параметры каскада на БТ с ОК: фаза сигнала на выходе совпадает с фа-

зой сигнала на входе; коэффициент усиления по току – десятки – сотни раз; ко-

эффициент усиления по напряжению меньше единицы; входное сопротивление 

– десятки – сотни  килоом; выходное сопротивление – единицы – десятки ом. 

 

Вариант Схема 
EГ, 

В 

UИП, 

В 

RГ, 

кОм 

R1, 

кОм 

R2, 

кОм 

R3, 

кОм 

R4, 

кОм 

R5, 

кОм 

С1, 

мФ 

С2, 

мФ 

С3, 

мкФ 

С4, 

нФ 

1 ОБ 2,1 15 1 20 2 0,13 0,9 5 3,3 33 15 0,05 

2 ОЭ 0,15 15 1,2 1300 1800 1,2 4,3 0,9 1,5 1 1,5 0,06 

3 ОК 1,5 15 5 29 40 1,1 – 0,15 5 – 470 100 

4 ОБ 1,1 15 1,5 12 2 0,15 1 5,5 3,1 30 18 0,01 

5 ОЭ 0,09 15 2 2000 1500 1,25 4,1 1 2 3 1,7 0,5 

6 ОК 0,9 15 4,5 35 23 1,2 – 0,2 4,5 – 320 10 

 

Транзистор BC546A (n-p-n) 

Вывести АЧХ по напряжению, АЧХ по току, ФЧХ по напряжению. 
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4.2. Лабораторная работа №2 

Разводка печатной платы 

 

Цель работы:  

Изучение процесса разработки печатной платы в пакете программ OrCAD. 

 

Схему для разводки печатной платы брать согласно варианту из лабо-

раторной работы №1. 

 

На рис. 4.4 изображена электрическая схема разводки печатной платы. 

 

 
Рис. 4.4 

 

Собираем схему в OrCAD Capture. Затем в корне проекта выбираем лист 

со схемой и выбираем Tools ->Create Netlist. Откроется окно на рис. 4.5. 

 

 
Рис. 4.5 
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Выбираем вкладку Layout. Выбираем пункты Run ECO to Layout и User 

Properties are in inches. В строке Netlist File указываем директорию, в которой 

сохранится файл со списком соединений.  

Для создания новой платы в окне Layout выбираем File ->New. 

Откроется окно (рис. 4.6): 

 

 
Рис. 4.6 

 

В первой строке указываем путь к файлу *.tch. Это заготовки плат. В 

данном случае используем файл _default.tch. 

Во второй строке указываем путь к файлу со списком соединений. 

В третьей строке задается имя результирующего файла. 

Нажимаем кнопку ApplyECO. 

В конце будет выдан отчет и откроется окно дизайна (рис. 4.7). 
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Рис. 4.7 

 

Далее рисуем контуры платы. Затем расставляем элементы на плате и 

выполняем трассировку (см. разд. 3 Layout). Полученный результат изображен 

на рис. 4.8. 

 
Рис. 4.8 
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4.3. Лабораторная работа №3 

Триггеры на логических элементах 

 

Цель работы:  

Изучение процесса моделирования цифровых устройств в программе 

Capture. 

RS-триггеры 

RS-триггер, или SR-триггер – триггер, который сохраняет своѐ предыду-

щее состояние при нулевых входах и меняет своѐ выходное состояние при по-

даче на один из его входов единицы. Условное графическое обозначение  

RS-триггера приведено на рис. 4.9. 

 
Рис. 4.9 

 

Таблица 4.1 

 

Таблица истинности RS-триггера 

S R Q(t) Q(t+1) 

0 0 0 0 

0 0 1 1 

0 1 0 0 

0 1 1 0 

1 0 0 1 

1 0 1 1 

1 1 х Не определено 

1 1 х Не определено 

 

Рассмотрим, как работает RS-триггер. Для правильной работы такого 

триггера на оба его входа необходимо подать сигналы логической единицы. 

Перевод триггера из одного устойчивого состояния в другое производится пу-

тем кратковременной подачи на один из входов единичного сигнала. При пода-

че единицы на вход S (Set) триггер переходит в единичное состояние. При по-

даче сигнала на вход R (Reset) триггер сбрасывается в ноль. 

Одновременная подача двух единиц на оба входа триггера недопустима, 

т.к. в этом случае работа триггера непредсказуема. В промежутке между сигна-

лами, когда на обоих входах ноль, триггер сохраняет ранее установленное со-

стояние. 

Если на обоих входах присутствует ноль, установленное состояние триг-

гера сохраняется все время, пока на схему подано напряжение питания. Таким 
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образом, триггер можно использовать для хранения информации. При выклю-

чении питания информация теряется. Если питание было выключено, то в       

момент включения питания (до прихода первых входных импульсов) триггер 

устанавливается в случайное положение. Если точнее, то это положение зави-

сит от того, какой из элементов триггера оказался более быстродействующим. 

RS-триггер используется для создания сигнала с положительным и от-

рицательным фронтами, отдельно управляемыми посредством стробов, разне-

сѐнных во времени. Также RS-триггеры часто используются для исключения 

так называемого явления дребезга контактов. Схемы RS-триггера с динамиче-

ским управлением, RS-триггера двухступенчатого синхронного и RS-триггера 

со статическим управлением указаны на рис. 4.10, 4.11, 4.12 соответственно. 

 

 
Рис. 4.10 

 
 

Рис. 4.11 
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Рис. 4.12 

 

D-триггеры 

 

Самый распространенный вид триггера – это так называемый D-триггер. 

Условное графическое обозначение D-триггера приведено на рис. 4.13. 

 
Рис. 4.13 

 

                                                                                                                 Таблица 4.2 

 

Таблица истинности D-триггера 

D Q(t) Q(t+1) 

0 0 0 

0 1 0 

1 0 1 

1 1 1 

 

D-триггер (D от англ. delay – задержка) – запоминает состояние входа и 

выдаѐт его на выход. D-триггеры имеют как минимум два входа: информаци-

онный D и синхронизации С. После прихода активного фронта импульса син-

хронизации на вход С D-триггер открывается. Сохранение информации в  

D-триггерах происходит после спада импульса синхронизации С. Так как ин-

формация на выходе остаѐтся неизменной до прихода очередного импульса 

синхронизации, D-триггер называют также триггером с запоминанием инфор-

мации, или триггером-защѐлкой.  

Вход D – это вход данных (от английского DATA). В процессе работы 

на этот вход подается логический уровень, который необходимо записать в  

D-триггер. 

Вход С называется тактовым. На него поступает тактовый импульс, син-

хронизирующий запись данных. 
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Импульсный вход (вход С) не чувствителен к уровню сигнала. Такой 

вход срабатывает в момент перехода от одного уровня к другому. Про такие 

входы говорят: срабатывает по переднему фронту (т.е. при переходе с нуля на 

единицу) или срабатывает по заднему фронту (т.е. при переходе от единицы к 

нулю). Иногда применяют другие технические термины для описания работы 

импульсного входа. В литературе можно прочитать: «вход срабатывает по 

фронту сигнала» или «вход срабатывает по спаду сигнала». 

Рассмотрим подробнее логику работы D-триггера. Для переключения 

триггера в нужное нам состояние сначала на вход D необходимо подать соот-

ветствующий логический сигнал. Для записи единицы на вход D подаем еди-

ницу, для записи нуля – ноль. Затем на вход С необходимо подать тактовый 

импульс. По спаду этого импульса триггер установится в нужное нам состояние 

(сигнал на D-входе запишется в триггер). Такая логика работы D-триггера дела-

ет его очень удобным устройством для хранения одного бита цифровой инфор-

мации (одного разряда двоичного числа). 

Схемы D-триггера с динамическим управлением, D-триггера синхронно-

го со статическим управлением и D-триггера со статическим управлением ука-

заны на рис. 4.14, 4.15, 4.16 соответственно. 

 

 
Рис. 4.14 

 
 

Рис. 4.15 
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Рис. 4.16 

 

JK-триггеры 

 

Условное графическое обозначение JK-триггера приведено на рис. 4.17. 

 
Рис. 4.17 

Таблица 4.3  

 

Таблица истинности JK-триггера 

J K Q(t) Q(t+1) 

0 0 0 0 

0 0 1 1 

0 1 0 0 

0 1 1 0 

1 0 0 1 

1 0 1 1 

1 1 0 1 

1 1 1 0 

 

JK-триггер работает так же, как RS-триггер, с одним лишь исключением: 

при подаче логической единицы на оба входа (J и K) состояние выхода триггера 

изменяется на противоположное. Вход J (от англ. jump – прыжок) аналогичен 

входу S у RS-триггера. Вход K (от англ. kill – убить) аналогичен входу R у  

RS-триггера.  

Если на J подать логический ноль, а на К – логическую единицу, то по 

спаду тактового сигнала триггер установится в нулевое состояние. Если на вхо-

ды J и К одновременно подать логическую единицу, то по каждому спаду так-

тового импульса триггер будет переключаться в противоположное состояние. 

То есть с единицы в ноль и с нуля в единицу. И, наконец, если и на J и на К по-
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дать логический ноль, то триггер перестанет реагировать на тактовые импульсы 

и его состояние будет оставаться неизменным.  JK-триггер в отличие от  

RS-триггера не имеет запрещѐнных состояний на основных входах, однако это 

никак не помогает при нарушении правил разработки логических схем. На 

практике применяются только синхронные JK-триггеры, т.е. состояния основ-

ных входов J и K учитываются только в момент тактирования, например, по 

положительному фронту импульса на входе синхронизации. 

Схемы JK-триггера со статическим управлением, JK-триггера с динами-

ческим управлением и одноступенчатого JK-триггера с внутренней задержкой 

указаны на рис. 4.18, 4.19, 4.20 соответственно. 

 
Рис. 4.18 

 

 
Рис. 4.19 

 
Рис. 4.20 
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Таблица 4.4 

 

Перечень используемых элементов 

Условное графическое изображе-

ние 
Название элемента 

 

NAN2 (логическое И-НЕ, библиотека DIG_PRIM) 

 

NAN3 (логическое И-НЕ, библиотека DIG_PRIM) 

 

INV (инверсия, библиотека DIG_PRIM) 

 

DigStim (цифровой источник сигнала, библиотека 

SOURCSTM) 

 

NOR2 (логическое ИЛИ-НЕ, библиотека DIG_PRIM) 

 

Процесс задания цифрового сигнала 

 

Чтобы задать сигнал, необходимо указать его имя. Для этого необходи-

мо дважды щелкнуть по строчке «Implementation= », после чего в появившемся 

окне Display Properties (рис. 4.21) в строке Value указываем имя сигнала.  
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Рис. 4.21 

 

Далее выделяем источник, в меню выбираем Edit>PSpice Stimulus. Запу-

стится приложение Stimulus Editor (рис. 4.22).  

 

 
Рис. 4.22 

 

В окне New Stimulus (рис. 4.23) в блоке Digital выбираем тип сигнала 

Bus. В графе Width вводится разрядность источника сигнала. В меню Initial Val-

ue выбираем начальное значение сигнала. 
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         Рис. 4.23                                                              Рис. 4.24 
 

Для разделения сигнала на участки с разным уровнем воздействия ис-

пользуется инструмент Add. Его можно найти в меню Edit>Add либо на ин-

струментальной панели с помощью кнопки  .  

Для изменения параметров участка сигнала необходимо выделить дан-

ный участок, выбрать Edit>Attributes либо на инструментальной панели кнопку  

. Откроется окно Edit Digital State (рис. 4.24). В поле Value вводится значе-

ние сигнала. В поле Start Time вводится время начала данного участка сигнала. 

В поле Duration вводится длительность данного участка сигнала. 

Для изменения параметров всего сигнала необходимо выделить имя 

данного сигнала, выбрать Edit>Attributes либо на инструментальной панели 

кнопку  . Откроется окно Digital Stimulus Attributes (рис. 4.25).  В поле Bus 

Width вводится разрядность сигнала. В меню Display Radix выбирается исполь-

зуемая система исчисления. 

 
Рис. 4.25 

Для добавления нового сигнала необходимо выбрать Stimulus>New либо 

на инструментальной панели кнопку  , после чего откроется окно New Stimu-

lus. 

После завершения всех изменений нужно их сохранить (File>Save). По-

сле сохранения будет предложено загрузить изменения в Capture. 

 

Вариант 1 2 3 4 5 6 7 8 9 

Схема 
рис. 

4.10 

рис. 

4.11 

рис. 

4.12 

рис. 

4.14 

рис. 

4.15 

рис. 

4.16 

рис. 

4.18 

рис. 

4.19 

рис. 

4.20 
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4.4. Лабораторная работа №4 

Цифроаналоговые преобразования 

 

Цель работы:  

Изучение процесса моделирования цифроаналоговых преобразователей в 

программе Capture. 

 

Схема ЦАП с суммированием напряжений 

 

Особенности этой схемы, называемой схемой с суммированием напря-

жений на резисторной матрице (рис. 4.26), состоит в том, что, во-первых, ис-

пользуются резисторы лишь с двумя значениями сопротивления (R и 2R). Во-

вторых, выходные напряжения триггеров непосредственно не участвуют в 

формировании выходного напряжения ЦАП, а используются лишь для управ-

ления состоянием ключей. 

 
Рис. 4.26 
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Рассмотрим подробнее работу такого преобразователя. В каждом разря-

де имеется два ключа, через один из них в резисторную матрицу подается 

напряжение Е, через другой – нулевое напряжение. Определим напряжения на 

выходе ЦАП, соответствующие единицам разрядов числа, помещаемого в ре-

гистр. Пусть в регистр введено число 1002. Триггер 3 в состоянии 1, и в третьем 

разряде открыт ключ (Кл 3), в остальных разрядах триггеры в состоянии 0 и от-

крыты ключи 2' и 1' (рис. 4.27, а). Последовательными преобразованиями мож-

но получить схему (рис. 4.27,  д), из которой следует, что напряжение в точке 

А3 равно 

UА3= UВЫХ = Е/3. 

Если в регистр поместить число 0102, то резисторную матрицу можно 

представить схемой, показанной на рис. 4.27, а. Путем преобразования ее мож-

но привести к схеме, представленной на рис. 4.27, в. 

 

 

 
а       б    в              г    д 

 

Рис. 4.27 

 

Возникающее в точке А2 напряжение имеет то же значение, что и в точке 

А3, схемы на рис. 4.28. Из рис. 4.28, б видно, что при передаче на выход преоб-

разователя это напряжение делится на два:  

UBЫX= UA2 = 0,5 E/3. Би
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                                           а                            б         в 

Рис. 4.28 

 

Можно показать, что при числе 0012 напряжение в точке A1 равно    

UВЫХ= E/3. При передаче этого напряжения в точку А2 и далее от точки А2 к 

точке А3 напряжение каждый раз делится на два и UВЫХ = 0,25 Е/3. 

Итак, напряжение на выходе, соответствующее единицам отдельных 

разрядов двоичного числа в регистре, пропорционально весовым коэффициен-

там разрядов.  

При n-разрядном регистре, обозначив цифры разрядов двоичного числа 

an, an-1, …, a1, получим выражение напряжения на выходе ЦАП: 

 
Из выражения видно, что выходное напряжение ЦАП пропорционально 

числу N, помещаемому в регистр. 

Аппаратурные погрешности преобразования в данной схеме связаны с 

отклонениями сопротивления резисторов от их номинальных значений, неиде-

альностью ключей (сопротивление реального ключа в закрытом состоянии не 

равно бесконечности, а в открытом – не равно нулю), нестабильностью источ-

ника напряжения Е. Наибольшее влияние на погрешность ЦАП оказывают эти 

отклонения в старших разрядах. 

 

Схема ЦАП с суммированием токов 

 

Схема ЦАП с суммированием токов. На рис. 4.29 показан еще один ва-

риант схемы ЦАП – схема с суммированием токов в резисторной матрице. 

Вместо источника стабильного напряжения Е в данной схеме используются ис-

точники стабильного тока I. Если триггер находится в состоянии 1, ток I источ-

ника через открытый ключ втекает в резисторную матрицу; если триггер в со-
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стоянии 0, то открывается другой ключ, который замыкает источник.  

На рис. 4.30, а показана схема, соответствующая числу 10002. 

Путем преобразования она приводится к эквивалентным схемам на  

рис. 4.30, б и в, откуда следует UM =UBЫX = 2/3 RI. Такое же напряжение образу-

ется в любой из точек А1, А2, А3, А4, если соответствующий разряд регистра со-

держит 1. При передаче напряжения между этими точками оно делится на два 

и, следовательно, выходное напряжение 

 

 
     Рис. 4.29       

 

Схема ЦАП на переключаемых конденсаторах 

 

Основой ЦАП этого типа является матрица конденсаторов, емкости ко-

торых соотносятся как целые степени двух. Схема простого варианта такого 

преобразователя приведена на рис. 4.31 (параллельный ЦАП на коммутируе-

мых конденсаторах). Емкость k-го конденсатора матрицы определяется соот-

ношением 

Сk = 2
k
C0.                       (4.1) 

а 

б в 
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Цикл преобразования состоит из двух фаз. В первой фазе ключи S0…SN–1 

находятся в левой позиции. Ключ сброса Sсб замкнут. При этом все конденсато-

ры разряжены. Во второй фазе ключ сброса Sсб размыкается. Если   k-й бит 

входного N-разрядного слова dk = 1, то соответствующий ключ Sk переключает-

ся в правую позицию, подключая нижнюю обкладку конденсатора к источнику 

опорного напряжения, или остается в левой позиции, если dk = 0. Суммарный 

заряд конденсаторов матрицы с учетом (1) составит 

                  (4.2) 

     

Равный заряд получает и конденсатор С в обратной связи ОУ. При этом 

выходное напряжение ОУ составит 
 

  Uвых= –q/C.              (4.3) 

 

 
Рис. 4.31 

 

Подставив (4.2) в (4.3), найдем окончательное значение выходного 

напряжения: 

 

 
 

Для хранения результата преобразования (постоянного напряжения) в 

течение сколь-нибудь продолжительного времени к выходу ЦАП этого типа 

следует подключить устройство выборки-хранения. Хранить выходное напря-

жение неограниченное время, как это могут делать ЦАП с суммированием ве-

совых токов, снабженные регистром-защелкой, преобразователи на коммутиру-

емых конденсаторах не могут из-за утечки заряда. Поэтому они применяются в 

основном в составе аналого-цифровых преобразователей. Другим недостатком 

является большая площадь кристалла ИМС, занимаемая подобной схемой. 
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Пример реализации четырехразрядного ЦАП в OrCAD показан на  

рис. 4.32  

 

 
Рис. 4.32 

 

Используемые элементы: 

 

 

S (ключ, управляемый напряжением, библиотека ANALOG) 
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Вариант Схема ЦАП Сигнал Период 

1 
С суммированием 

напряжений 

 

24 мс 

2 
С суммированием 

токов 

 

15 мс 

3 
На переключаемых 

конденсаторах 

 

16 мс 

4 
С суммированием 

напряжений 

 

20 мс 

5 
С суммированием 

токов 

 

32 мс 

6 
На переключаемых 

конденсаторах 

 

10 мс 
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